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1 Introduction

Dear user
Please read the instructions carefully before operating the VarioCAM® head.
Doing this ensures, that you will be able to make full use of the features of your new thermal imaging
system.

Te

c

The specifications described in the manuel refer to the standard package of VarioCAM® head. Depending
on orders and individual adjustments, technical data or accessores delivered with your thermography
camera can be different from the described specifications. What fundamentally counts is the regulation of
your order instead of the manuel.

Copy deadline:

September 2003

Document number:

017907-001-98-01-0602-de

JENOPTIK Laser, Optik, Systeme GmbH
07745 Jena/GERMANY

fra

InfraTec GmbH
01217 Dresden/GERMANY
phone:
+49 351 871-8615
fax:
+49 351 871-8727
e-Mail:
service@infratec.de

In

CE

Note:
No part of this instruction manual may be reproduced in any form (print, photocopy, microfilm or any other
process) or processed, duplicated or distributed using electronic systems without the written permission
of JENOPTIK Laser, Optik, Systeme GmbH. This instruction manual was produced with the necessary
diligence. No liability is accepted for damages arising from non-observance of the information contained
in this instruction manual.
All the stated product names and trademarks remain in property of their respective owners.
We reserve the right to modify this document for technical advancements.
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1

Introduction

VarioCAM® head is a robust infrared camera for precise real-time thermography. Based on an uncooled
microbolometer array, VarioCAM® head was specially conceived for use in preventive maintenance. The
camera is especially suitable for industrial use due to the compact design and the high degree of
protection. The low weight of the appliance and the long battery running time enable effective use of the
system for plant inspection.
IR images can be saved on Compact Flash cards.

Typical applications of the system include:

In

fra

Te

Process inspection
Printed circuit board inspection
Material examinations
Control of process temperatures
Quality assurance

c

VarioCAM® head quickly records the surface temperature of objects without contact. The radiometric
measuring function of the camera allows the resolution of temperature differences better than 0.1 K.

2
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2

Device safety information

General
VarioCAM® head is a high-quality, accurately calibrated, optical measuring instrument. Handle it with
appropriate care. Avoid soiling the optical surfaces.
The device has the IP 65 protection class.
Observe the conditions mentioned in the Technical Data (see Section 3.3
transport of the device.

Page 8) for use, storage, and

c

Use the carrying case or original packaging for transporting VarioCAM® head.

Te

Opening the camera case is reserved for customer service or authorised staff. Interference by the user or
unauthorised persons is not allowed and results in voidance of any guarantee claim.
Only use accessories or spare parts, which are expressly recommended for VarioCAM® head by
JENOPTIK Laser, Optik, Systeme GmbH. Otherwise malfunctions or damage can occur. Guarantee
claims are void for such damage.

Standards, Guidelines

fra

VarioCAM® head complies with the requirements of the following standards:

In

DIN 58390/environmental tests
DIN ISO 9022/Mechanical-dynamic loads
EN 55011, EN 50082-2, EN 61000-3-2/EMV

Operating Instructions
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2 Device safety information

Handling
Only use ATA compatible Compact Flash memory cards in the PCMCIA slot of the VarioCAM®
head. Otherwise damage to the camera or the memory card can arise, for which no liability will be
accepted.
Changing lenses should not be done in rooms with high dust content or humidity, as the protection
class IP 65 is not guaranteed for a detached lens.

Te

c

The VarioCAM® head thermography system is equipped with a highly-sensitive uncooled
microbolometer detector. The individual detector elements are microscopically small thin layer
resistors on waferthin membranes, which are arranged self-supporting some microns above the
silicon selection circuit. The radiant heat of the scene is mapped from the optics of the
thermography system on to these detector elements and is absorbed by them. This results in a
temperature change in the detector elements, which results in electronic evaluable signals via the
temperature co-efficient of the respective thin layer resistor. The detector elements are installed in
a vacuum casing for the purpose of high sensitivity.

In

fra

Very high radiant fluxes can result in overheating of these thin layer resistors, which can result in
irreversible changes in their properties. The optics and electronics concept of VarioCAM® is so
designed that object radiation up to 2,000° C occurring in thermographic practice do not cause any
changes in the detector. However, direct sunlight or direct reflections of the same in the VarioCAM®
field of view must be absolutely avoided, because these can cause irreversible changes, whose
origin is clearly detectable, in the microbolometer detector. The manufacturer accepts no liability for
damages of this type caused to the microbolometer detector! In certain circumstances, when the
equipment is switched off and directed to the sun, it cannot be ruled out that damage to the
detector occurs, therefore when VarioCAM® head is not in use, the supplied lens cover must be in
place.

4
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3

Technical Description

3.1

Operating Principle

3.2

Te

c

VarioCAM® head is a thermal imaging system for the spectral range (8... 13) µm (LWIR).
The IR-lens of the camera displays the object scenery on a microbolometer array with a resolution of
320 x 240 pixels. The analogue video signal of the detector array is prepared by the internal electronics.
The electronics contain all the necessary functions for camera operation such as activation of the
microbolometer array, A/D conversion, offset- and gain correction, defective pixel treatment, and video
and PC interfaces.
There is a choice of operating the camera using RS232 or via the PC interfaces. Depending on
equipment version there is an RS232-interface and an IEEE 1394-interface (optional equipment).
Special software packages are required to use these interfaces. You will find details of these in chapter
9.3, Installation of the FireWire driver for VarioCAM® head page 46.

Description of the function units

Lens

fra

The camera lens captures the IR radiation emitted by the object in the field of view and displays it on the
detector array. Field of view (FOV) and resolution (IFOV) are determined by the focal length of the lens
used. The standard lens 1.0/25 (f=25mm) has a FOV 32° x 25° and an IFOV 1.8mrad (1.8mm at 1m
object range).
The object range can be set between 0.4m and infinity.
Additional lenses are available for special applications:
Lenses
Lens

In

Wide angle lens
Standard lens
Telephoto lens

Focal distance (mm) min. focus (m)
12.5
0.2
25
0.5
50
2.0

Close-Up Lenses (for standard lens)
Close-Up Lens
Focus (mm)
0.17x
149
0.5x
50

Operating Instructions

FOV (°)
(64 x 50)
(32 x 25)
(16 x 12)

Image field (mm²)
(87 x 66)
(28 x 22)
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Detector
VarioCAM® has an uncooled microbolometer detector with 320 x 240 elements. The detector is thermally
stabilised with high-precision using Peltier element and is thus independent of the ambient temperature.
For the camera user, the use of an uncooled detector means quick availability of camera operation after
switching on and long operating life (MTTF) in continuous use.

Detector Electronics
The detector electronics provide the necessary bias currents and pulse frequencies for detector operation
and provide the pre-processing and digitalisation of the analogue video output signal of the detector.

Image Processing Electronics

c

Real-time image processing with the following essential functions (depending on the equipment) is
realised with the help of FPGA and embedded PC:

fra

Te

Detector electronics interface
Gain- and offset correction
Defective pixel treatment
Low-pass filtering
Zoom generator
Graphic overlay
IEEE1394 interface (isochronous)
Embedded PC interface
Standard format-video image generator (PAL/S-VHS)

Opto-mechanics

The following functions are realised with the help of the opto-mechanics assembly group:
Focussing (motor focus)
Effective range change-over (lens apertures)
Internal NUC (Non Uniformity Correction) using internal shutter

In

Furthermore, this assembly group has an optional module for increasing the camera's geometric
resolution (Resolution-Enhancement).

6
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Operation
VarioCAM® head is predominantly designed for stationary or semi-portable applications. For these cases
of operation the camera is usually operated by a host computer. Depending on the camera equipment
this takes place either via the RS232 port or via the IEEE1394 interface. The appropriate operating
software is described in Section 6.

Power Supply
The VarioCAM® has the following power supply options
external wall power supply 15 V or
IEEE1394 interface (optional)

Interfaces

Te

c

The mains adapter is connected to the 6-pole socket on the back of the camera.
For devices with IEEE1394 interface (only available for certain equipment versions), the supply voltage
can be taken directly from the PC interface card.

The camera has the following interfaces as standard equipment:

fra

Compact Flash slot
RS232
Composite Video, S-Video
Input for external trigger signal
IEEE1394 (optional equipment)

In

Die Anordnung der Schnittstellen zeigt die Fig. 1.

Fig. 1

Camera Interface

With the exception of IEEE1394, it is possible to use the interfaces via a breakout box. The camera is
connected to this box with a 14-pole cable. The supply voltage comes from a 15 VDC mains adapter and
is fed into the breakout box. The image information is available as Composite Video or as an S-VHS
signal. Suitable monitors can be connected to the breakout box with standard cables.
Furthermore, VarioCAM® head also has on optional digital interface (IEEE1394). In conjunction with the
IRBIS® online or IRBIS® control software package, the camera can be remote-controlled and real-time
digital image information can be transmitted to a PC via this interface.

Operating Instructions
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3.3

Technical Data

Spectral range
Temperature measurement range
Temperature resolution @ 30 °C
Measurement accuracy

(8 ... 13) µm
(-40 ... 1.200) °C, optional > 2.000 °C
better than 0.1 K

Emissivity
Recording process/image format (pixels)
Detector
IR-image frequency
Standard telephoto lens, FOV, IFOV, min. focus
Standard lens, FOV, IFOV, min. focus
Close-up lens 1 on standard lens, FOV, IFOV
Close-up lens 2 on standard lens, FOV, IFOV
Standard wide angle lens, FOV, IFOV, min. focus
A/D conversion
Image storage
Language recording/text commentary
Real-time storage
Analogue interfaces
Digital interfaces
Power supply
Power consumption
Working temperature range
Storage temperature range
Humidity during operation and storage
Dimensions (complete equipment)
Weight (complete equipment)
Tripod connection
Automatic functions
Protection class in operation
Shock resistance
Vibration resistance in operation

adjustable from 0.1 to 1.0 in steps of 0.01
Focal Plane Array (320 x 240)
patented uncooled microbolometer array
50/60 Hz
50 mm, (16 x 12)°, 0.9 mrad, 2 m
25 mm, (32 x 25)°, 1.8 mrad, 0.5 m
0.17 x, (87 x 66) mm, 149 mm
0.5 x, (28 x 22) mm, 50 mm
12.5 mm, (64 x 50)°, 3.6 mrad, 0.2 m
16 Bit
CF card, optional FireWire (IEEE 1394)
image-integrated
Optional internal storage up to 873 images
PAL/NTSC-FBAS and S-Video
RS232, optional FireWire (IEEE 1394)
mains adapter, optional FireWire (IEEE 1394)
ca. 8 W
(-15 ... 50)°C
(-40 ... 70)°C
relative humidity 10 % to 95 %, not precipitating
(195 x 130 x 90) mm
ca. 1,9 kg
1/4" screw thread
Autofocus, Autoimage, Autolevel, Image Storage
IP 65, IEC 529
25G, IEC 68-2-29
2G, IEC 68-2-6

In

fra

Te

c

±2 K, ±2 %
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4

Unpacking and Checking

On receipt of the VarioCAM® head please check for completeness and that the components are not
damaged. The supplier must be informed immediately of any damage.
The VarioCAM® head system is delivered in an equipment case or in transport packaging.
The basic package contains the following components:

c

VarioCAM® head camera with LW IR 1.0/25
VarioCAM® head instruction manual
Transport case
Optional accessories:

fra

Te

FRIWO MPP 30 (15 V DC) mains adapter with 6-pole LEMO connector
Compact Flash card
Lens protective cover
LW IR 1.0/12.5 wide angle lens
LW IR 1.0/50 telephoto lens
Breakout box
IEEE1394 14-pole cable
IEEE1394 6-pole cable.
IEEE1394 PCI card
Equipment stand

In

In addition, 2 macro lenses (2x, 6x) for the IR lens LW IR 1.0/25 are available. More details about these
are available on request.

Operating Instructions
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5

Starting Up

5.1

Preparations

VarioCAM® head is designed as a stationary system. A floor plate is used for fixing the camera, in which
there is a 1/4"-20 thread (photo thread according to DIN 4503) and other metric tapped holes. Depending
on equipment the VarioCAM® head is controlled via the RS232 or the IEEE1394 interface. Various
software packages are available for this. The corresponding cable connection to the PC must be made
first.

Using a Stand

c

5.1.1

5.1.2

Te

The installation of VarioCAM® head on a stand (optional accessory) is recommended for blur-free camera
exposures, especially for Resolution-Enhancement-Mode. There is a 1/4"-20 photo thread (DIN 4503) for
this on the underside of the device for this.

Power Supply Connection

The wall power supply is connected to the 6-pole socket provided for it on the back of the camera.

5.1.3

Inserting a Memory Card

fra

If you want to save digital thermal images on a Compact Flash card, first remove the cover for the
Compact Flash slot on the back of the camera. Then insert a (ATA-compatible) Compact Flash medium in
to the slot provided for it on the back of the camera. Please pay attention to the correct orientation of the
card. The save process is executed by means of a corresponding command via the RS232 or the
IEEE1394 interface.

5.1.4

Lens Replacement

In

Only perform replacement of lenses in a room as free of dust as possible. The system's IP 54 protection
class is not guaranteed for a detached lens! Place the camera on a suitable base, so that the lens is
facing you. Hold the bayonet ring with your right hand and pull the lock on the camera outwards with your
left hand. Now turn the bayonet ring anti-clockwise, so that both the red markings on the lens are side by
side and detach the lens. Now align the replacement lens, so that the red markings on the lock and the
bayonet ring are on top of each other. Then insert the lens into the camera and turn the bayonet ring
clockwise until the lock engages.

10
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5.1.5

Operation with Breakout Box (control via RS232)

First make the cable connection between the camera and the breakout box. The supplied 14-pole
camera cable is used for this.
Afterwards, connect the breakout box to a free COM port of the host computer.
Finally, the supplied wall power supply is connected to the breakout box.
Then press the C-button.

c

The LED on the back of the camera then starts to flash. The appliance is ready for use after approx. 40
seconds. The LED then lights without flashing.

fra

Te

The VarioCAM® head disposes of analog interfaces, PAL/NTSC-FBAS and S-Video, as well as digital
interfaces, RS232 and optional FireWire (IEEE 1394). The break out box can be connected to the camera
with a system cable, divide the signals generated from the camera and thus make them available for
external usage.

Power supply, 12V operating voltage
Interface for connection cable to camera
Interface for external trigger input

Breakout Box (Power supply, connection to camera, trigger input)

In

Fig. 2

BNC - video interface (PAL/NTSC-FBAS)
Serial interface (RS232)
S-Video

Fig. 3

Breakout Box (BNC, RS232, S-Video)

Operating Instructions
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5.1.6

Operation via the IEEE1394 Interface

If necessary, first install the IEEE1394 interface card in the computer. Please refer to the accompanying
documentation for information about this. A 6-pole IEEE1394 cable is provided for connecting the camera
to the interface card. The appliance power supply comes from the PC in this configuration.

5.2

First Use

We recommend the following procedure for the first operation of VarioCAM® head:

Te

c

Remove the lens protective cover.
Verify that the battery or mains adapter is connected.
Switch on the camera by pressing the "C" button briefly.
The green LED on the back starts to flash.
The appliance is ready for use after approx. 40 seconds. The duration of the power-on process
depends on the ambient temperature.
Point the camera at a warm object and press the "A" button. This activates the Autoimage function, and a
thermal picture of the selected object appears in the viewfinder. Adjust the viewfinder to your eye using
diopters equalisation. For focussing on the distance of the object, press on the joystick briefly (focus
mode appears) and move the joystick upwards (far) or downwards (near).

Connection VarioCAM® head - PC/Notebook

fra

5.3

The thermography system VarioCAM® head can be connected to PC/Notebook with the enclosed
FireWire (IEEE 1394) cabel.

In

The automatic hardware recognition reports to the first-time connection of the Thermography-camera with
the PC/Notebook. For further policy about the installation of FireWire (IEEE 1394)-drivers for VarioCAM®
head, please refer to chapter 9.3, Installation of the FireWire driver for VarioCAM® head till FirmwareVersion 2.093 page 46.

12
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5.3.1

Description of the thermography system FireWire (IEEE 1394)
connection
1. A connection from thermography system to the PC is made
with the 6-pole FireWire (IEEE 1394) cable (Fig. 4). In doing so,
the 6-pole FireWire (IEEE 1394) cable must be connected with
an IEEE 1394 PCI card integrated in the PC.

Fig. 4 FireWire (IEEE 1394)
6-pole cable.

c

Te

Fig. 5 FireWire (IEEE 1394)
4-pole cable.

A connection from the thermography system to the notebook
is made with the 4-pole FireWire (IEEE 1394) cable (Fig. 5). In
doing so, the 4-pole FireWire (IEEE 1394) cable must be
connected with the IEEE 1394 FireWire connection integrated in
the notebook.
(alternatively PCMCIA CardBus card)
2. There is a 6-pole LEMO connector (Fig. 6) at the other end of the
6-pole or 4-pole FireWire (IEEE 1394) cable.

Fig. 6 LEMO 6-pole connector

fra

3. The 6-pole LEMO connector is connected to the 6-pole LEMO
socket (Fig. 7) on the thermography system.
Please ensure the connection is made to the correct LEMO
socket!
Note: Plug the LEMO connector with the red dot at the top into
the socket. Do not apply excessive force.

Fig. 7
LEMO socket
(6-pole and 14-pole)

Description of the thermography system power supply

In

5.3.2

Fig. 8

power supply

When operating the thermography system on a notebook
(FireWire connection without electricity supply), this must
be connected to the 6-pole LEMO socket (Fig. 7) via a
power supply (accessory).
Note: If the thermography system is operated without a
power supply on a PC, it must be ensured that the
FireWire cards recommended by Infratec are used.
Otherwise Infratec makes no guarantee of functionality.

1. The power supply is connected with the Adapter P
(Fig. 9) for using the 14-pole LEMO socket.
Please ensure you use the correct LEMO connector
(yellow marker)!
2. The 14-pole LEMO connector of the Adapter P
(Fig. 9) is connected to the 14-pole LEMO socket
Fig. 9 Adapter P for adaptation of the 6(Fig. 7) on the thermography system.
pole power supply cable to 14-pole
Please ensure you use the correct LEMO socket!

Operating Instructions
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Detailed connection description

6

The VarioCAM®/VarioCAM® head can be connected with the PC/notebook using the following connection
possibilities. Thereby, it must be noted that certain components are optional and not always supplied as
accessories depending on the configuration of the thermography system.

VarioCAM® head (VCh)

Te

6.1

c

If the VarioCAM® head thermography system is operated without a power supply on a PC
(electricity supply via the FireWire interface), it must be ensured that the FireWire cards
recommended by Infratec are used. Otherwise Infratec makes no guarantee of functionality.
When using the FireWire interface of the VarioCAM®/VarioCAM® head, the FireWire plug
must be connected to the PC/notebook first and then connected to the VarioCAM® with the
LEMO connector.

Vch with FireWire cable and power
supply

fra

The VarioCAM® head is connected with the 6-pole
LEMO socket using the 6-pole FireWire cable
from the notebook (4-pole)/PC (6-pole). The
power supply is connected to the 14-pole LEMO
socket of the VarioCAM® head via the Adapter P.

The Adapter P (power supply adapter) must
only be used in connection with the power
supply!
Fig. 10 Vch with 6-pole FireWire cable and power
supply

Vch with power supply and universal
cable
®

In

The VarioCAM head is supplied with electricity
via the power supply (without adapter). The 6-pole
LEMO connector of the VarioCAM® head power
supply is connected with the 6-pole LEMO socket
of the VarioCAM® head. The universal cable is
connected to the 14-pole LEMO socket of the
VarioCAM® head.

Fig. 11 Vch with power supply and universal cable

14
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6.2

VarioCAM® (VC)

VC with FireWire cable and power supply
The VarioCAM® is connected with the 6-pole
LEMO socket using the 6-pole FireWire cable
from the notebook (4-pole)/PC (6-pole). The
power supply is connected to the 14-pole LEMO
socket of the VarioCAM® via the Adapter P.
The Adapter P (power supply adapter) must
only be used in connection with the power
supply!

VC with FireWire cable and battery

Te

The VarioCAM® is connected with the 6-pole
LEMO socket using the 6-pole FireWire cable
from the notebook (4-pole)/PC (6-pole). Thereby,
the VarioCAM® is supplied with electricity via the
battery. An external power supply is not
necessary in this case.

c

Fig. 12 VC with 6-pole FireWire cable and power
supply

fra

Fig. 13 VC with 6-pole FireWire cable and battery

VC with power supply and universal
cable

In

The VarioCAM® is supplied with electricity via the
power supply (VarioCAM® without battery). The 6pole LEMO connector of the VarioCAM® power
supply is connected with the 6-pole LEMO socket
of the VarioCAM®. The universal cable is
connected to the 14-pole LEMO socket of the
VarioCAM®.

Fig. 14 VC with power supply and universal cable

VC with battery and universal cable

The VarioCAM® is supplied with electricity via a
battery. An external power supply is not
necessary in this case. The universal cable is
connected to the 14-pole LEMO socket of the
VarioCAM®.

Fig. 15 VC with battery and universal cable

Operating Instructions
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Menu structural VarioCAM® head

7

After powering on (pressing the C-button) and brief initialisation, the camera is in live mode. The menu
structure of a thermografic camera can be controled by thermografic camera itself as well as by software
IRBIS® remote (see chapter 10, IRBIS® remote Software page 66).

7.1

Live-Mode

temperature level
temperature range

-¯
¬®

In

fra

can be optimised.

Te

Using the joystick, the thermal picture with respect to

c

In Live-Mode, a temperature bar is displayed which allocates the object temperatures to the colour
representation of the thermal picture. The active temperature range (minimum and maximum
temperature) is represented with the temperature bar.
The colour palettes can be changed by pressing the C-button. The VarioCAM®-Palette is the default.

Fig. 16

Live Mode

Pressing Enter changes to Focus Mode (see Focus Mode 7.2
A long press of the T-button opens the Spot-Editor
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7.2

Focus Mode

Fig. 17

Focus-Modus

Te

c

Focus Mode is reached with Enter.

A greater object distance - or a smaller object distance ¯ can be focussed on using the joystick. A bar

fra

displays the relative focus position. Moving the joystick in the ® - direction zooms the image
electronically. The zoom factor is reduced again with ¬. The zoom factor (1 to ca. 4.3) is displayed in a
bar. It must be pointed out, that the T-button in an electronic zoom leads to the measurement spot
display. TL opens the Spot Editor (see chapter 7.3 page 17).
Enter switches back to Live Mode (see chapter 7.1

7.3

page 16).

Spot Editor

The Spot Editor is reached from all other states via the T-button (TL).

In

It contains three states:
SPTPOS
SPTDIM
SPTEPS

These states are used for definition and processing of measurement spots or measurement areas.
A measurement area with the smallest possible resolution of 2x1 pixels is termed a measurement spot.
These can be used for selective temperature measurement. If the spot is enlarged, we are dealing with a
measurement area. Here it is possible to display a minimum or maximum temperature value and the
average temperature across the measurement area. For simplification, only the expression
"measurement area" will be used below.
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Fig. 18

Status bar in the status "SPTPOS" (top), "SPTDIM" (middle), "SPTEPS" (bottom)

In Fig. 18 the status bars of the individual states are displayed for a rough overview of the possible
functions. These functions are described in more detail below.

Status "SPTPOS"

fra

Te

c

The "SPTPOS" status is reached after long pressing the T-button (TL) in the Live or Freeze display. The
position of the measuring areas can be changed here. This status is exited automatically after ca. 30 sec
of inactivity. The display then switches back to the previous display mode. The first time the TL is pressed
(no measurement area has been defined yet), a new Spot in approximately the centre of the infrared
image is generated automatically (see Fig. 19 Spot 1).

Fig. 19

View of the Spot Editor with a standard measurement area

The joystick buttons are used to change the position of the current measurement area. In doing so, the -,

In

¯ buttons move the Spot vertically upwards or downwards. The ¬, ® buttons can be used for left or right
movement.
The next measuring area can be activated with the T-button. In doing so, the current measurement area
is displayed with a blue background.
A new measurement area is regenerated approximately in the centre of the screen, if TL is pressed. A
total of up to five measuring areas can be defined.
The C-button is used to delete a measurement area. If the last measurement area is deleted by doing
this, the last display mode is returned to.
The status "SPTDIM" is reached by pressing the A-button. This is used for establishing the dimensions of
the measurement area. This status is now explained in more detail.
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Status "SPTDIM"
The measurement area dimensions can be modified in the "SPTDIM" status. However, after 30 seconds
of inactivity, this status is exited automatically. The display then reverts to the previous display mode.
The joystick buttons are used to change the dimensions of the current measurement area. Thereby, the or ¯ buttons alter the measurement area vertically and make it larger or smaller. The ¬, ® buttons can
be used for a reduction or enlargement horizontally. The maximum dimensions of a measurement are
restricted, so that the other elements still remain visible.
The "SPTEPS" status is reached by pressing the A-button. This is used for establishing the emission
ratio of the measurement area. This status is now explained in more detail.

c

Status "SPTEPS"

Te

The emission ratio of a measurement are can be modified in the "SPTEPS" status. This status is exited
automatically after 30 seconds of inactivity. The display then reverts to the previous display mode.

In

fra

The emission ratio of the current measurement area can be changed using the joystick buttons. The
buttons ¬, ® can be used to reduce or increase the emission ratio by 0.1. The joystick buttons -, ¯ are
used for reducing or increasing the emission ratio by 0.01. The emission ratio set ultimately affects the
temperature calculation within the measurement area.
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7.4

Main Menu

Fig. 20

Main Menu

Te

c

The main menu is opened by a longclick on the joystick.
In the main menu, active configurations for image display, file creation and processing, the measurement
function, and key assignments can be set or queried with the direct functions.

fra

Navigation between the menu items is done using ¬ / ® on the joystick.
The ¯ joystick button opens the corresponding submenu.
Navigation through the submenus is analogous to that of the main menu.

7.4.1

Menu "Image"

In

The following is displayed for the Image submenu:

Fig. 21

Menu "Image"

The "Image" submenu is shown in Fig. 21. In this menu, all the relevant functions for displaying the
infrared picture are summarised.

20
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Menu item "Palette"

Fig. 22

Menu item "Image"

"Palette"

Colour palettes: VarioCAM®, black-white, iron colours, blue-red, black-white marked, rainbow

fra

Fig. 23

Te

c

This menu item centralises all the available palette functions for the display of the infrared image's
separate temperatures. The current assignment of individual colours to the corresponding temperatures
can be seen from the colour key on the right-hand edge of the screen.
It is possible to change the colour palette of the thermograph image, and there is a choice of the following
colour palettes:

Fig. 24

Dialogue for palette selection

In

A dialogue box for selection from the predefined palettes is opened via the menu item "Select..". This
palette will be used afterwards for representing the temperatures of the infrared image. The palette can
also be changed by pressing the C-button in the camera's Live display.

Fig. 25

Greyscale colour key (left) and its inverted display (right)

The palette's colour form can be controlled with the "Inverse" menu item. If this function is active, the
current palette is inverted. For example, if the greyscale palette is set, the lower temperatures are
displayed in shades with more black and the higher temperatures in shades with more white as standard.
If the "Inverse" function is now activated, this representation is reversed, so that the lower temperatures
are displayed in shades containing more white and the higher ones with more black (see Fig. 25).
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Fig. 26

Colour key 256 colours(left)and 16 colours (right)

Fig. 27

Te

c

The "16 Steps" menu item toggles between the standard colour depth of 256 colours and a lower colour
depth of 16 colours It is usually possible to distinguish between up to 256 different temperature values
with colours. By activating the "16 Steps" function, only 16 temperature values can be distinguished. This
gradation is also particularly visible on the colour key (see Fig. 26).

linear greyscale colour key (left) and its logarithmic representation (centre), and 16 colour
logarithmic representation (right)

In

fra

The representation of the temperature values can be toggled between a linear and a logarithmic
progression with the "Logarithmic" menu item The default representation of the temperatures is a linear
progression. By activating this function, it is possible to use a greater colour resolution for the lower
temperature range than for the higher. The effects of the logarithmic representation can be seen in Fig.
27. The linear colour key is shown on the left. In the centre, the colour key with logarithmic representation
set is shown. For better clarity of the logarithmic separation, a representation with only 16 colours is
shown on the right. Here, the higher colour resolution for the lower temperatures is also clear.
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Menu item "Image Filter"

Fig. 28

Menu item "Image"

"Image filter"

Using this menu item, a filter is adjustable for the representation of the infrared images. A first order
digital lowpass is used as filter. This operates approximately as an accumulation across several images.
The four filter levels "Off", "Weak", "Medium" and "Strong" can be selected from the submenu. The
stronger the filter is adjusted, the less snow there is in the image. This is particularly noticeable in a small
temperature range.

Te

Fig. 29

c

Menu item "Image elements"

Menu item "Image"

"Image elements"

This menu item contains the functions for the appearance of the user interface. The menu contains the
three sub-options "only thermogram", "Elements.." and "Font fat".

In

fra

By selecting the "only thermogram" option, all displayed overlays on the graphical user interface are
hidden in one action. If this function is active, a checkmark is displayed on the left next to the menu item.
The logo and the status of the Compact Flash card cannot be removed from the infrared image.

Fig. 30

Dialogue "Inserts"

A dialogue box (see Fig. 30) for individual selection of the graphical user interface overlays to be
displayed is opened with the menu item "Elements..".
Using the menu item "Font fat", the font can be toggled between a narrow and a wide font. The narrow
font is the default for the display of all text. The use of the wide font can be helpful, for example, when
viewing the user interface with a video monitor.
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Menu item "Isotherms.."

Fig 31

Menu "Image"

"Isotherms.."

Thermograph image in greyscale colour key and overlaid isotherms

fra

Fig. 32

Te

c

This menu item contains functions for processing the definable isotherms. It is possible to process the
isotherms using an editor.

Fig. 33

Isotherm editor help bar

In

The isotherm editor is reached via the menu item "Isotherms.." (see Fig 31). This is indicated with the
status "ISOTH". Using this editor, it is possible to define up to five isotherms, which can be used with a
special colour for the identification of a temperature range (see Fig. 32). In Fig. 33, the status bar is
illustrated with the most important keys for this status. These are now described in more detail below.
Using the joystick buttons, it is possible to establish the level and the range of the isotherms. For this, the
keys -, ¯ are pressed to move the level of the isotherms upwards or downwards. The keys ¬, ® reduce
or increase the range of the isotherms.

Fig 34

Colour palette for isotherms

The S-key must be used to change the colour of the isotherms. For this, one press on this key switches
on the next corresponding colour of the colour palette illustrated in Fig 34.
An additional isotherm can be created with TL. It is possible to define up to five isotherms. In doing so,
the active isotherm is always identified with a grey bar on the left-hand side (in the temperature scale).
The T-key is used to switch between the individual isotherms.
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A defined isotherm always relates to a fixed temperature level and to a fixed temperature
range. Thus, in Live Mode, if the temperature level is moved or the displayed temperature
range is modified, the isotherm is adjusted accordingly.

Menu item "Level/Range.."

"Level/Range.."

Fig. 36

Dialogue "Level/Range"

c

Menu "Image"

Te

Fig 35

If the "Level/Range" menu item is selected, the dialogue box for manual setting of the values for the
temperature level and temperature range is displayed ( see Fig. 36).

fra

The numeric setting can be achieved using the joystick. For this, the desired value is selected with the -,
¯ joystick keys and the value set using the ¬, ® joystick keys when positioned on the number. The T-key
is used to change between the input fields.

Menu "File"

Fig. 37

Menu "File"

In

7.4.2

Fig. 37 shows the structure of the "File" menu. This contains all file system-related functions. The
individual options are described in the following sections.
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Menu item "File load"

"File load.."

Fig. 39

Dialogue "Load image.."

c

Menu "File"

Te

Fig. 38

After selection of the "File load.." option, a dialogue is displayed (see Fig. 39), where the saved IRB files
were stored. The file to be loaded is selected with the joystick keys and confirmed afterwards with Enter.
Furthermore, this dialogue can be used for setting the current directory. For this simply select the
directory and exit from the dialogue afterwards with C. All files will be saved in this directory from now on.

fra

Next to the list of files, a preview picture of an IRB file is displayed on the right (providing the preview was
also saved). Underneath the image, the character "A" signifies, that the IRB file also contains a language
comment. A "V" means an included VIS image.

In

Menu item "Comment.."

Fig. 40

Menu "File"

"File load.."

Fig. 41

Dialogue "Comment"

Selecting this menu item the diaolgue for the input of a comment pops up (see Fig. 36). This comment will
be saved with the thermographic image.
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Menu item "Sav. format.."

Menu "File"

"Sav. format.."

Fig. 43

Dialogue "Saving config"

c

Fig. 42

Te

The formats for the files to be saved are configurable with the menu item "Sav. Format..". A dialog is
displayed for this (see Fig. 43). There are four possible choices available.
The following table shows the result of each selection:
Selection 1

I = save the visual image in the IRB

Audio

I = save the audio data in the IRB

Selection 2
B = also saves the visual image
as a BMP file
W = also saves the audio data
as a WAV file

fra

Sav. format
VIS

Screen
Data

B = saves all of the current screen as a
BMP file
I = saves measurement definitions in
the IRB

In

With T-key (acting as tab) you can move between the individual selection fields. The selection is made
with the joystick keys -, ¯. At least one format should be selected for saving files.
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Menu item "File delete.."

"File delete.."

Fig. 45

Dialogue "Delete"

c

Menu "File"

Te

Fig. 44

A dialog will be showed after choosing "File delete.." (see Fig. 45), where the saved IRB-files are. Use
Joystick-keys -, ¯ to choose files to be deleted then press Enter to confirm. The chosen files will be
irrevocably deleted.

fra

This action is irreversible!

Menu item "Gallery" (optional)

Menu "File"

"Gallery"

In

Fig. 46

Fig. 47

Dialogue "Gallery"

The menu item "Gallery" displays previews of all IRB files at the CompactFlash-Card are displayed (see
Fig. 47). The IRB file which is to be loaded is selected with the joystick and confirmed by Enter. Pressing
the S-button the first file in the gallery is being selected. The T-button switches to the last file in the
gallery. CL will change the palette.
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Menu item "Create folder.."

Menu "File"

"Create folder.."

Fig. 49

Dialogue "Create directory"

c

Fig. 48

Te

It is possible to create directories on the Compact Flash card with this function. Directories can only be
created in the root directory, that means there is only one directory level. After creating the directory, this
immediately becomes the current directory and will be used for all files saved later.

fra

Menu item "Format CF card.."

Menu "File"

"Format CF card.."

In

Fig. 50

Fig. 51

Dialogue "Format CF card"

After selecting the "Format CF card.." option the following dialogue appears. Enter will result in deleting
all data on the card and formatting the card. All data on the card are deleted!
This action is irreversible!
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Menu item "Format CF card.." (optional)

Fig. 52

Menu "File"

"BG memory"

This function is available in selected VarioCAM® head systems only!

fra

Te

c

The Background-Memory editor is accessed by the menu item "BG-Memory" (see Fig. 52). Being in this
mode "BG REC" will be displayed (see Fig. 53).

Fig. 53

Thermographic image in BG-Memory mode "REC"

This editor offers the option to record sequences of images into the background memory of the
thermographic system.
50 Hz).

In

By moving the joystick -, ¯ the frequency of the image saving is determined (0.25Hz

The recording is started resp. stopped by Enter. The number of images being recorded is displayed as
well as the percentage of the background memory being used.
To replay the recorded sequence press T-button. T-button will always allow to change between the
"REC" and the "PLAY" mode.
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Thermographic image in background memory mode "PLAY"

2500Hz.

Te

The frequency of replaying can be changed moving the joystick -, ¯ in the range of 0.25Hz
Moving the joystick ¬, ® the recorded sequence can by replayed back resp. forward.
By pressing the A-button level and range of the image are automatically adapted.

Pressing the S-button will result in saving the thermographic image on the CF-card.

In

fra

CL will bring you back to the live mode of the camera.
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7.4.3

Fig. 55

Menu "Measure"

Menu "Measure"

Fig. 56

Menu "Measure"

Te

Menu item "Maximum" and "Minimum"

c

The "Measure" menu contains all the functions for temperature measurement. The menu structure is
shown in Fig. 55. The individual options are described in more detail below.

"Maximum" (left) & "Measure"

"Minimum" (right)

In

fra

It is possible to overlay maximums and minimums. These can also be overlaid in Spots and indicate
afterwards the warmest and coldest point in the infrared image and the overlaid measurement areas (see
Fig. 56).

Fig. 57
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Menu item "Differences" (optional)

Fig. 58

Menu "Measure"

"Differences"

fra

Te

c

By means of the menu item "Differences" temperature changes of certain areas within the
thermographic image can be displayed. The areas are to be marked by a measuring area/spot before
(see Chapter 7.3 page 17).

Fig. 59

Thermoimage with time-difference

Fig. 60

Thermoimage with place-difference

Selecting the menu item "Differences" "Time" the measurement of temperature changes of selected
measuring areas/spots over time will start (see Fig. 59).

In

The menu item "Differences"
"Location" will provide temperature differences between several
measurement areas/spots. The absolute temperature of the measuring area 1 and the temperature
differences in respect of other measuring areas will be displayed (see Fig. 60). The current temperature
differences of the measuring areas are displayed underneath the scale.
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Menu items
"Emissivity..", "Env. temp..", "Transmissivity.." and "Path temperature.." , "Distance.."

Menu "Measure"

"Emissivity.."

Fig. 63

Menu "Measure"

"Env. temp.."

Fig. 62

Dialogue "Emissivity"

Te

c

Fig. 61

fra

Fig. 64

Menu "Measure"

"Transmissivity.."

In

Fig. 65

Dialogue "Env. temperature"

Fig. 66

Dialogue "Transmissivity"

Fig. 67

Menu "Measure"

"Path temperature.."

Fig. 68

Dialogue "Path temp."

Fig. 69

Menu "Measure"

"Distance.."

Fig. 70

Dialogue "Object distance"

The environmental conditions for the recorded infrared images can be established with the four menu
items "Emissivity..", "Env. temp..", "Transmissivity..", "Path temperature.." and "Distance..". On
selection of a menu item, a corresponding dialogue is displayed, which permits the input of the desired
value. The desired value can then be set using the joystick keys. This value is adopted after pressing
Enter.
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Menu item "Material table.."

Menu "Measure"

"Material table.."

Fig. 72

Dialogue "Table of materials"

Te

c

Fig. 71

The "Material table.." menu item opens a dialogue (see Fig. 72), where various materials are listed. The
appropriate material can be selected here. Afterwards the emissivity for the selected material is preset.

fra

Menu item "Profile" (optional)

Menu "Measure"

"Profile"

In

Fig. 73

Fig. 74

Thermographic image with profile

Using this function temperature profiles of the thermographic images can be displayed (see Fig. 74). To
deactivate the profile check it off in the menu.
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7.4.4

Fig. 75

Menu "Settings"

Menu "Settings"

The settings menu is shown in Fig. 75. It contains all the functions for setting the camera.

Fig. 76

Menu "Settings"

Te

c

Menu item "Extra" (optional)

"Extra"

fra

The menu item "Premium" will result in an accumulation of thermographic images to reduce the noise of
the image. The "ResEnhanc" (Resolution Enhancement) feature activates a procedure to increase
resolution of the thermographic image. The object is scanned several times which results in an image
with 640 x 480 pixels. If activated these menu items will be checked.
Both methods are only used if thermographic image is saved.

The features "ResEnhanc" and "Autosel Calib" are available in certain models only.

In

Menu item "Calib" (optional)

Fig. 77

Menu "Settings"

"Calib"

A submenu is displayed, where all available camera calibration ranges are listed
(see Fig. 77) and switching between them is possible. For this, the corresponding menu item simply has
to be selected. If the "Autosel Calib" option is active, the camera always switches automatically to the
optimum calibration range for the measurement.

36

© InfraTec GmbH 2007

Operating Instructions

Operating Instruction for VarioCAM® head
7 Menu structural VarioCAM® head

Menu item "Automatic"

Fig. 78

Menu "Settings"

"Automatic"

Fig. 79

Te

c

The available automatic functions of the camera are centralised under the "Automatic" menu item:
The options "Level" or "Range" provide automatic adjustment of the infrared image in relation to the
temperature level or temperature range used. If one of the two functions is active, this is indicated by a
checkmark in front of the menu line.

Dialogue "Auto Saving"

fra

On selecting "Save", a dialogue is displayed, which allows a sequence of infrared images to be recorded.
The starting time of the recording must be entered in the first field. The current time is the default here.
The time can be adjusted with the - and ¯ joystick keys. The ¬ and ® joystick keys can be used to move
between the individual time fields. When setting the time, it should be noted, that this is in the range of
00:00:00 to 23:59:59.

In

The field "Interval" contains the frequency by which a thermographic image is being taken (in seconds).
The field "Number" indicates the number of thermographic images to be taken. To reduce the noise of
the thermographic image to be saved some thermographic images can be accumulated which is
determined by checking the field "PremiumSnap". The values of each single field can be set by moving
the joystick -, ¯, ¬ and ®. By pressing the T-button the field is being selected. The setting of the
sequence has to be confirmed by Enter. Pressing the C-button all settings are deleted and the dialogue is
exited.
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Menu item "A-key"

Fig. 80

Menu "Settings"

"A-key"

c

The "A-key" menu item is used to configure which actions should be executed when the A key is
pressed. The option "Compensation" and "Autoimage" in the submenu can be (de)activated for this. If
the option is activated, this is indicated with a checkmark.
An homogenisation of the image is performed for a "Compensation".
The "Autoimage" option provides automatic adjustment of temperature level and range. That means the
best settings for both these parameters are selected according to the content of the image for display.

Menu "Settings"

"Compensation"

fra

Fig. 81

Te

Menu item "Compensation"

Fig. 81 shows the "Settings"
compensation parameters.

"Compensation" menu. This menu is used for setting the image

In

There is a choice of both "Shutter" and "Object/intern" types, and the current setting is marked with a
bullet. In the example shown in Fig. 81, the current compensation is set to the camera shutter.

Fig. 82

Dialogue "adjustment interval"

The interval for an automatic compensation is adjustable via the "Interval.." option. On selection of this
menu item, the dialogue shown in Fig. 82 is displayed. Here, the time in seconds, after which an
automatic compensation should always be performed, must be input. The limits for entering the interval
are 5 sec and approx. 16 min (995 sec). If the value entered exceeds or is below these limits, it is
adjusted automatically. However, the value 0 is a special case, which makes it possible to switch off the
automatic compensation.
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Menu item "Alarm" (optional)

Menu "Settings"

"Alarm.."

Fig. 84

Dialogue "Alarm definition"

c

Fig. 83

Te

In the menu item "Alarm.." temperature thresholds can be defined. Is any of the thresholds reached, a
function defined in "Action" will be carried out.
If there are any spots/measuring areas activated in the thermographic image (see Chapter
7.3 page 17) the alarm function is only valid for the respective spot/area. Otherwise the
alarm function is activated for the whole image.

fra

Two alarm thresholds can be defined. In both selection fields ("Alarm 1/2") it can be defined a
surpassing "-" and undergoing "¯" as well as averaging "M" of a temperature set in "Threshold 1/2".

In

The field "Action" contains the function which is to be carried out in the case of an alarm.
"S" (Save) saved a thermographic image.
"V" (Visualisation) visualised the alarm with the respective temperatures (see Fig. 85, see Fig. 86).
"X" (Extern) a trigger impuls is put to the trigger output of thermografic camera.

Fig. 85

Display of a visual alarm in the case of surpassing and undergoing (- ¯) of the temperature
thresholds in the whole thermographic image

Fig. 86

Display of a visual alarm reaching an average of the temperature (M) in measuring area 1 and
surpassing of the temperature threshold (- ) in measuring area 2
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Menu item "Config"

Fig. 87

Menu "Settings"

"Config"

Fig. 88

Te

c

If the "Config" menu item is selected, a submenu is displayed, where it is possible to save or load the
camera configuration and to configure default settings.

Dialogue "Load configuration"

Fig. 89

The "Save" option is used to save the current
configuration. (1-5)

fra

It is possible to load a configuration with the
"Load.." option. (1-5)

Dialogue "Save configuration"

Fig. 90

Dialogue "Start behaviour"

In

On selection of the "Start.." menu item, a dialogue is displayed (see Fig. 90), where the start behaviour
of the thermograph camera can be defined.
"Autofocus"
"AutoImage"
"AutoLevel"
"AutoCalib"

"FixLevel"
"FixSpan"
"RS232"

The camera should automatically set the best focus for the scene on starting.
Automatic adjustment of the temperature level and range at the scene.
Only the temperature level at the scene should be adjusted automatically.
The best calibration range corresponding to the scene temperature will be set on starting
the camera.
Sets the temperature level setting to a fixed value of 20°C on starting the camera.
The camera should set a fixed temperature range of 40K on starting.
The communication via the serial port is initialised and activated on starting the camera.

The Enter key is pressed to save the settings, whereupon the dialogue also closes. If the changes made
should be discarded, press the C-key.
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Fig. 91

Dialogue "Start behaviour"

"Update" offers the option to update the firmware of the camera from a CompactFlash card (see chapter
8 page 43). The password "1234" has to be confirmed by Enter.

Fig. 92

Menu "Settings"

Te

c

Menu item "System"

"System"

fra

The options for changing the system settings can be reached from the "System" menu item (see Fig.
92).

Fig. 93

Dialogue "Date/Time"

In

The dialogue shown in Fig. 93 is reached via the "Date/Time.." menu item. Here, the current date and
time for the camera can be set.

Fig. 94

Dialogue "Select language"

The dialogue shown in Fig. 94 is reached via the "Language.." menu item. Here, the language for the
camera's graphical user interface is selected
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Fig. 95

Dialogue "Select temperature unit"

Dialogue "Accumulator state"

Te

Fig. 96

c

On selecting the "Unit.." menu item, the dialogue shown in Fig. 95 is displayed. Here, there is a choice of
the temperature units "°Celsius", "°Fahrenheit" and "Kelvin".

fra

Select the "Battery.." menu item to check the battery status. Thereupon, the operating data and the
display of the current battery supply are listed in a message window (see Fig. 96) by means of the
FireWire (IEEE 1394)-interface.

Fig. 97

Dialogue "System info"

Information about the system can be displayed in the menu item "Systeminfo..". The actual version of
the firmware can be identified as well as the current version.

In

C Camera-Version
F FPGA-Version
I IFC-Version
K KCP-Version
O OMI-Version
Serial number of the camera

The communication via the serial connection can be activated/deactivated by checking the menu item
"RS232".
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8

Execute camera update

8.1

Preparation
An uninterrupted power supply is the precondition of an update of the camera. IF the
update is interrupted by a failure of power supply the camera has to serviced by the
manufacturer.

Place a CompactFlash card in the PC.

c

Select the relevant parts of the update and the respective files and transfer them to the root of the CF
card.

Te

Only files which are part of the update are to be copied to the root of the CF card.

Thereafter the CF card is to be put into the camera.
Parts of the update and respective files:

fra

Firmware
Languages, default configuration, palettes, fonts, menu(s)
Camera configuration
Calibration
Gain correction 1 to 8
Gain correction 9 to 12, calibration 1 to 12
FPGA-Code(s)
PIC-Codes

FLSHCAL1.BIN
FLSHCAL2.BIN
FLSHFPGA.BIN
FLSHPIC.BIN

Start

In

8.2

FLSH1MB.BIN
FLSHUID.BIN
FLSHCNF.BIN

The update of the camera is started by the menu item "Settings" - "Config" - "Update.."
(see Chapter 7.4.4 page 36).
The password is "1234" and it has to be confirmed by ENTER.
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8.3

Process

During the update all parts of the update are handled step by step (see Chapter 8.1). When the
respective file is found, the information as in Fig. 98 appears.

Fig. 98

Information for updating the thermographic camera

Fig. 99

c

The progress of updating the respective part is to be seen in the status line.
Is the update of the respective part is finished the following information is displayed (see Fig. 99).

Information about the successful finish of an update part

Fig. 100

Te

Is there no file for some update part the following information appears:

Information if update part is missing

fra

Each information is on display for about 5 sec. before the next part is updated. After all update parts are
passed resp. gone over the following information appears for 5 sec (see Fig. 100).

Fig. 101

Dialogue for finished update

Starting the camera again the update will be activated.

Error Information

In

8.4

Before the actual update the tool for updating the camera tries to deactivate all automatic functions which
could lead to any disconnection of the power supply. If this is not possible because of the current settings
of the camera the update will not be started and the following information is displayed (see Fig. 102).

Fig. 102

Dialogue in the case of cancellation of the update

Another try is possible. If several tries fail the camera should be started again.
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9

Hardware and Software Installation

9.1

Basics

A PC connection of the VarioCAM® thermograph camera is realised using the IRBIS® online thermograph
special software. This contains the following functions:
Remote control of camera functions
Real-time transfer, display, and storage of digital thermograph measurement data

c

The following hardware interface is used for communication between PC and the thermograph camera:
FireWire (IEEE1394) interface

Te

Using the FireWire (IEEE1394) interface, the continuous digital data stream supplied by the thermograph
camera is recorded image synchronously and prepared for display, evaluation and storage by IRBIS®
online.
The VarioCAM® head thermograph camera makes the digital image information available in a 16 bit data
width (14 bit digitalisation depth) over FireWire (IEEE1394).

Hardware Components

fra

9.2

Control and Evaluation PC

The FireWire (IEEE1394) interface card is installed inside the control and evaluation PC or a FireWire
(IEEE1394)-interface is installed on a notebook.

Components for digital data transfer and camera control

In

If the VarioCAM® head is to be controlled with a notebook, the thermograph camera must be supplied
with electricity via an external mains adapter. A 4-pole FireWire (IEEE1394) cable makes the hardware
connection between notebook and VarioCAM® head.
®
If a (desktop) computer is used to communicate with the VarioCAM head, an external power supply is
not mandatory. However, a 6-pole FireWire (IEEE1394) cable is used here to connect the thermograph
camera and the computer with each other.
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9.3

Installation of the FireWire driver for VarioCAM® head till
Firmware-Version 2.093

Hardware preparation

9.3.1

Driver installation under Windows
®

c

The VarioCAM® or the VarioCAM® head (only the VarioCAM® is mentioned in the following) and the
computer or the notebook are connected with the supplied FireWire (IEEE 1394) cable. Afterwards the
computer or notebook and the thermography system must be switched on. If the boot process of the
computer or the notebook is completed and the thermography system is ready for operation, the
automatic Windows hardware recognition reports "New hardware found" and starts the add new
hardware wizard. The integrated FireWire (IEEE 1394) interface makes the VarioCAM® represent a PC
peripheral which is recognised by the operating system and whose driver installation is started
automatically on first use.

2000

In

fra

Te

The hardware drivers for the VarioCAM are automatically copied into the "/driver" subdirectory with the
successful installation of the IRBIS® control software. If the installation of the IRBIS® control software has
been completed successfully, the hardware installation can be started with the Windows add new
hardware wizard:

Fig. 103
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Microsoft Windows Found New Hardware Wizard

select driver

In

fra

Select the option "Display a list of the known drivers for this device so that I can choose a specific
driver" and continue the wizard by clicking "Next >".

Fig. 105

Microsoft Windows Found New Hardware Wizard

Select hardware type

Select the "IEEE 1394 Bus host controller" hardware type and continue the wizard by clicking
"Next >".
The "IEEE 1394 Bus host controller" must be selected without fail otherwise no connection
between the VarioCAM® and computer is possible.
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Microsoft Windows Found New Hardware Wizard

Select a Device Driver

fra

You reach the "Install from Disk" dialogue with the "Have Disk..." button:

Microsoft Windows Found New Hardware Wizard

Input driver path

In

Fig. 107

You start the "Locate File" dialogue (cf. Fig. 108) with "Browse...":
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Fig. 108
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In

fra

The directory where IRBIS control has been installed (the default directory is Irbislc) must be selected for
locating the driver files for the VarioCAM®. This directory contains the "driver" subdirectory which
contains the required files.

Fig. 109

MicrosoftTM WindowsTM Found New Hardware Wizard

Select driver file

The file "variocam.inf" must be highlighted and the "Locate File" dialogue confirmed with "Open".
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Microsoft Windows Found New Hardware Wizard Confirm driver path

In

fra

Te

Confirm the "Install from Disk" dialogue with "OK".

c

Fig. 110

Fig. 111

Microsoft Windows Found New Hardware Wizard

Select a Device Driver

As the "Variocam Infrared Camera" is the only model and is already selected, the installation can be
continued by simply clicking on "Next >".
Possible Windows warning messages against continuing the installation (cf. Fig. 112)
must be ignored. Confirm the continue installing message with "Yes".

Fig. 112
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Microsoft Windows Found New Hardware Wizard

Start Device Driver Installation

In

fra

Start the installation of the driver for the VarioCAM® with "Next >".

Fig. 114

Microsoft Windows Found New Hardware Wizard

Finished driver installation

The VarioCAM® hardware installation has been completed successfully. Afterwards, close the wizard with
"Finish".

Operating Instructions

© InfraTec GmbH 2007

51

Operating Instruction for VarioCAM® head
9 Hardware and Software Installation

9.3.2

Driver installation under Windows XP

fra

Te

c

The hardware drivers for the VarioCAM® are automatically copied into the "/driver" subdirectory with the
installation of the IRBIS® control software. If the installation of the IRBIS® control software has been
completed successfully, the hardware installation can be started with the Windows add new hardware
wizard:

Fig. 115

Microsoft Windows Found New Hardware Wizard

start dialogue

In

In this part of the wizard, the option "Install from a list or specific location (Advanced)" must be
selected. Afterwards, continue the wizard with "Next >".
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Microsoft Windows Found New Hardware Wizard

select driver

In

fra

Select the option "Don t search. I will choose the driver to install" and continue the wizard with
"Next >".

Fig. 117

Microsoft

Windows

Hardware Assistant Select hardware type

Select the "IEEE 1394 Bus host controllers" hardware type and click "Next >" to continue.
It is essential to select the "IEEE 1394 Bus host controllers", otherwise a connection
between VarioTHERM and the computer is NOT possible!!!

Operating Instructions

© InfraTec GmbH 2007

53

Fig. 118

Te

c

Operating Instruction for VarioCAM® head
9 Hardware and Software Installation

Microsoft Windows Found New Hardware Wizard

Select hardware type

fra

Click the "Have Disk..." button in this part of the wizard.

Microsoft Windows Found New Hardware Wizard

Input driver path

In

Fig. 119

You start the "Locate File" dialogue (cf. Fig. 120) with "Browse...":
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In

fra

The directory where IRBIS® control has been installed (the default directory is C:\Program Files\IRbislc)
must be selected for locating the driver files for the VarioCAM®. This directory contains the "driver"
subdirectory which contains the required files.
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Microsoft Windows Found New Hardware Wizard

Select driver file

fra

Te

The file "variocam.inf" must be highlighted and the "Locate File" dialogue confirmed with "Open".

Fig. 122

Microsoft Windows Found New Hardware Wizard Confirm driver path

In

Confirm the "Install from Disk" dialogue with "OK".
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Microsoft Windows Found New Hardware Wizard

Select a Device Driver

As the "Variocam Infrared Camera" is the only model and is already selected, the installation can be
continued by simply clicking on "Next >".

fra

Possible Windows warning messages against continuing the installation (cf. Fig. 124)
should be ignored. Confirm the continue installing message with "Yes".

Warning against continuing the installation

In

Fig. 124

Operating Instructions

© InfraTec GmbH 2007

57

Fig. 125

Te

c

Operating Instruction for VarioCAM® head
9 Hardware and Software Installation

Microsoft Windows Found New Hardware Wizard

start Device Driver Installation

In

fra

Click the "Next >" button to start the driver installation for the VarioCAM®.

Fig. 126

Microsoft Windows Found New Hardware Wizard

Finished driver installation

The VarioCAM® hardware installation has been completed successfully. Afterwards, close the wizard with
"Finish".
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9.4

Installation of FireWire-Drivers for VarioCAM® head with
DCAM-support from Firmware-Version 2.094

The VarioCAM® head with DCAM-support and the PC/Notebook should be connected with the delivered
FireWire (IEEE 1394) cable. After the VarioCAM® head with DCAM-support is connected to the
PC/Notebook via FireWire (IEEE 1394), the camera will appear under device manager of Microsoft
Windows XP Professional (see Fig. 128 / Fig. 129 page 60) as "Generic 1394 Desktop camera" by
the first installation.

In

fra

Te

c

On other operating systems, e.g. Microsoft Windows 2000, VarioCAM® head with DCAM-support will
appear under device manager as "JENOPTIK L.O.S. GmbH VarioCAM" (see Fig. 127) by the first
installation. The procedure is however the same as by "Generic 1394 Desktop camera".

Fig. 127

Device manager of other operating systems, e.g. Microsoft
®
VarioCAM head
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In order to use software from IRBIS®-family, the thermography camera has to be installed as VarioCAM®
head. This can be done by right mouse click on "Generic 1394 Desktop camera" (see Fig. 128 / Fig.
129), and the following dialog will appear:

Fig. 128

Device
manager
of
Microsoft
Windows
XP
Professional
with
®
connected VarioCAM head

Fig. 129

Device manager of Microsoft Windows
XP Professional with connected, but not
ready VarioCAM® head

In

If the symbol
appears in front of "Generic 1394 Desktop camera", right mouse click on "Generic
1394 Desktop camera" and choose "Uninstall" in the opened submenu (see. Fig. 129). Then click on
the symbol
"Scan for hardware changes" of Windows® device manager. As a result, "Generic 1394
Desktop camera" as in Fig. 128 will be shown under the category "Imaging devices".
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Fig. 130

Te

c

With a right mouse click, a submenu will show. Choose the menu item "Update Driver..." to start the
following dialog:

Microsoft Windows Found New Hardware Wizard

start dialogue

In

fra

In this part of the wizard, the option "Install from a list or specific location (Advanced)" must be
selected. Afterwards, continue the wizard with "Next >".

Fig. 131

Microsoft Windows Found New Hardware Wizard

select driver

Select the option "Don t search. I will choose the driver to install." and continue the wizard with
"Next >".
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Hardware-Assistent of Microsoft

Windows

choose hardware type

In

fra

Click on the button "Have Disk...".

Fig. 133

Microsoft

Windows

Found New Hardware Wizard

Input driver path

You start the "Locate File" dialogue (cf. Fig. 120) with "Browse...".
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Windows

Found New Hardware Wizard

Locate File

In

fra

The directory where IRBIS® online has been installed (the default directory is C:\Program Files\IRbiso)
must be selected for locating the driver files for the VarioCAM® head. This directory contains the "driver"
subdirectory which contains the required files.

Fig. 135

Microsoft

Windows

Found New Hardware Wizard

Select driver file

The file "VarioDCAM.inf" must be highlighted and the "Locate File" dialogue confirmed with "Open".
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Microsoft

Windows

Found New Hardware Wizard Confirm driver path

In

fra

Te

Confirm the "Install from Disk" dialogue with "OK".

c

Fig. 136

Fig. 137

Microsoft

Windows

Found New Hardware Wizard

Select a Device Driver

As the "Variocam Infrared Camera (DCAM)" is the only model and is already selected, the installation
can be continued by simply clicking on "Next >".
Possible Windows warning messages against continuing the installation (cf. Fig. 138)
should be ignored. Confirm the continue installing message with "Yes".

Fig. 138
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Windows

Found New Hardware Wizard

start Device Driver Installation

In

fra

Click the "Next >" button to start the driver installation for the VarioCAM® head.

Fig. 140

Microsoft Windows

Found New Hardware Wizard

Finished driver installation

®

The VarioCAM head hardware installation has been completed successfully. Afterwards, close the
wizard with "Finish".
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IRBIS® remote Software

10

fra

Te

c

IRBIS® remote enables remote control of the thermograph camera and the display of a visualisation for
the VarioCAM® head (based on the VarioCAM® display).

Fig. 141

IRBIS® remote starting screen

In

Before the software is completely usable, IRBIS® remote must be installed and correctly configured.
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10.1 Configuration

fra

Te

c

First start and mandatory configuration

Fig. 142

IRBIS® remote configuration

In

After starting the program for the first time or after starting the program from the Start Menu, the dialog
shown above is displayed, which is used for quick program configuration.

Category "Language"

The language for the remote control software interface can be switched between "German" and
"English".

Category "Components"

The components to be used can be set here. The remote control software is able to communicate with
the camera via an RS232 interface and a display of the analogue video signal. If part of this functionality
is not required (e.g. because the corresponding hardware is not available), it can be disabled here.
For the component selection, at least one of the components must be activated, otherwise
there would be no point in starting the program.
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Category "Framegrabber"
This is used for selection of the framegrabber to be used for the display of the analogue video signal. In
the current version of the software, there is a choice of both the "Falcon" and "HaSoTec (FG33)"
framegrabber types.
This setting is disabled, if the "Video Connection" component in the category
"Components" is disabled.

Category "Resolution"

c

The size of the video image display can be adjusted in the category "Resolution". The camera operates
with a resolution of 320 x 240 pixels. The display size can be doubled for improved legibility of the video
image on the PC. This is done by selecting the "640 x 480" option.

Category "Others"

Te

This section contains other possible settings.
The cable connection for the communication with the camera via RS232 can be set in the "Serial Port
No." dropdown box. All available PC serial ports are displayed in the dropdown box. The corresponding
port must be selected here.
In addition, using the "Show Special Buttons" field, you can choose whether the keyboard shortcuts for
controlling the camera should be displayed. These shortcuts will always be displayed if the checkbox for
this field is ticked.

fra

The "Others" section is disabled, if the "Serial Communication" component in the
"Components" section is disabled.

In

When all the appropriate settings have been made, the dialogue can be ended. In doing so, all
configurations will be saved and the software restarted if necessary.
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10.2 Changing the options

Fig. 144 "Additional" tab

In

Fig. 143 "Options" tab

Fig. 145

Program system menu

The dialogue shown in Fig. 143/Fig. 144 is used for additional software settings. This dialogue is reached
by clicking on the "Options..." entry in the application's System Menu (see Fig. 145). It has several tabs.
Using the "Options " tab (see Fig. 143), general program settings can be made. For the most part,
these correspond to those of the configuration dialogue (see chapter 10.1 Configuration page 67).
Some additional program control parameters can be adjusted on the "Additional" tab (see Fig. 144).

Operating Instructions

© InfraTec GmbH 2007

69

Operating Instruction for VarioCAM® head
10 IRBIS® remote Software

Language, Components, Framegrabber, Resolution

Fig. 146

Dialogue "Falcon

Video Settings"

page

c

Modifying these settings is done in the same way as described in the Configuration chapter 10.1
67.

fra

Timeouts for Initialisation

Te

In addition, there is a button "..." next to the Framegrabber settings "Falcon" entry "..." for configuring
the video input for the Falcon Framegrabber. If the button is pressed the dialogue shown in Fig. 146 is
displayed. The video input to be used can be set here. The changes are applied with "OK" and discarded
with "Cancel".

Fig. 147

Setting the timeouts for initialisation

In

In the category "Timeouts For Initialization" (see Fig. 143
Page 69), the maximum permissible
waiting time in seconds for the initialisation of a component can be specified. For example, if no
framegrabber card is installed, yet the analogue video component is activated, then using the example
shown in Fig. 143 (Page 69), the establishment of such a connection will be attempted for a maximum of
15 seconds. After this, the initialisation is cancelled and the video components are automatically disabled.
The "Serial Communication [sec]" or "Video Connection [sec]" input field is disabled, if the
"Serial Communication" or "Video Connection" component in the "Components" settings
(see chapter 10.1 Page 67) is disabled.
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Others

Fig. 148

Other options

Fig. 149

Te

c

Additional possible settings are contained in the "Others" section (see Fig. 148).
In the first of these, the cable connection for communication with the camera via RS232 can be specified
in the "Serial Port No." dropdown box.

Error message "Communication with the thermograph camera lost"

In

fra

The time interval in seconds, for checking the availability of the camera, can be adjusted In the "CameraAlive-Test [sec]" input field. For this, a test command is sent to the camera periodically and it is checked
whether the camera responds. If there is no response from the camera, an error message is displayed
(see Fig. 149). After acknowledgement of the message with "OK", establishing the connection is
attempted again.
The value in the "Pause After Initialisation [sec]" input field gives the time in seconds, for which the
initialisation window (see Fig. 162
Page 76) remains displayed after successful initialisation. This
influences how long the initialisation status is visible. If this should not happen, enter the value "0". The
initialisation window is then closed immediately.
In addition, using the "Show Special Buttons" field, it can be selected whether the keyboard shortcuts
(see Fig. 165 Page 77) for controlling the camera should be shown. These buttons are then always
shown, if the checkbox for this field is ticked (see Fig. 148).
The "Serial Port No.", "Camera-Alive-Test [sec]" and "Show Special Buttons" fields are
disabled, if the component "Serial Communication" was disabled in the "Components"
settings (see chapter 10.1 Page 67).
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Additional Options
The parameters for serial communication and the video display can be manipulated via the "Additional"
tab (see Fig. 144) .
These parameter settings should be changed with extreme caution, as possible software
malfunctions can arise. This is pointed out again in the appropriate places. If the program
no longer functions normally, the standard values shown in the separate illustrations must
be set.

Fig. 150

Input field "Number of Sending Tries" on the "Additional" tab

fra
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The number of attempts for sending a control command to the camera can be entered in the "Number of
Sending Tries" field (see Fig. 150) . This number is important, if faults in the transmission phase occur
and the camera thus does not understand the command the first time. Irrespective of the value set here,
the command is always sent at least once. The value entered is a maximum limit. If this limit is reached,
sending the command is aborted. In this case, the error message shown in the illustration below is
displayed.

Fig. 151

Error message "Communication error"

Fig. 152

Input field "Pause Between Commands [ms]" on the "Additional" tab

In

Using the "Pause Between Commands [ms]" field, it can be controlled how many milliseconds should
elapse between sending two commands to the camera.
As the camera only has a limited processing speed, this value should not be set too low,
otherwise it can result in buffer overflows and thus to communication errors for fast
command sequences.
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Fig. 153

Input field "Timeout For Command [ms]" on the "Additional" tab

The "Timeout For Command [ms]" regulates the maximum time the application should wait for a
response from the camera to a control command. The waiting time must be entered in milliseconds.
Given the signal transmission and processing times for commands, this value should not
be set too low, otherwise communication errors can arise.

Fig. 154

Input field "Grabtimeout [ms]" on the "Additional" tab

In

fra
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The "Grabtimeout [ms]" input field is used to control the time in milliseconds, after which the grabbing of
an analogue video image should be aborted. The possible lower limit for this value depends on the PC
processor speed and the Framegrabber card used.

Fig. 155

Error message by grabbing a analog video image

After the unsuccessful attempt to grab a new image, the further grabbing of images will be aborted after
the specified time and an error message will be displayed. In such a case, it is recommended to check
the video connection cables and connectors. If an analogue video image can be successfully grabbed
again, it will be displayed.

Fig. 156

Input field "SleepInterval in Mainloop [ms]" on the "Additional" tab

The "SleepInterval in Mainloop [ms]" shows the pause time in the main loop of the application in
milliseconds. This time is primarily important for other applications, as with a sleep time of zero
milliseconds for example, hardly any computer capacity is available for these applications. On the other
hand, a higher value for the sleep time slows down the display speed of the analogue video image and
the reaction time of the program to keypresses.
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Fig. 157

Input field "Time For Longclick [ms]" on the "Additional" tab

For operating the camera, there is a distinction between short and long clicks (see chapter 10.3 page
76). In order to reproduce this function on the PC, the time in milliseconds for a longclick can be adjusted
via the "Time For Longclick [ms]" input field shown in Fig. 157.
The time for a longclick should not be set too short, otherwise it can happen, that every
press on a button is evaluated as a longclick.

Input field "Q-Filter Param For FPS" on the "Additional" tab

c

Fig. 158

Fig. 159

Te

The speed in images per second (FPS) is shown in the status line for the analogue video image. The
individual data is filtered so that the display of the value is steadier. The necessary parameter for this is
adjustable with the "Q.Filter Param For FPS" input field on the "Additional" tab (see Fig. 158). The
smaller this value the less influence there is from strong data deviations. One should be used as the
maximum value. The incoming new data are 100% included in the calculation of the images per second.

Input field "Update Interval for FPS [ms]" on the "Additional" tab

fra

An additional adjustable parameter for the display of the images per second of the analogue video image
is available via the "Update Interval for FPS [ms]" input field (see Fig. 159). Here, the time interval in
milliseconds is entered, for which the display of images per second should be updated in the status line.
The smaller the selected time the more often the value is updated. This can result in a flickering of the
display.

Fig. 160

Input field "Firewire

Wait For Ready Time [sec]" on the "Additional" tab

In

The VarioCAM® head registers at the system with an entry into the Windows registration. This can take
a few seconds. In input field "Firewire Wait For Ready Time [sec]" can be specified, how long the
connection from PC/Notebook to thermography camera should take, in order to set an entry on the
system for the availability of the thermography camera. The value should not be smaller than 10.
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Applying the changes

Fig. 161

Dialogue window "Restart needed" after modifying options

c

Click the "OK" button (see Fig. 144) to apply the changes. Afterwards, all settings are saved. If a
program restart is necessary after applying the changes, the dialogue shown in Fig. 161 is displayed. This
dialogue must be confirmed with "Yes". If "No" is selected, the program does not restart and the
changes do not become effective until the next time the program is started.

In

fra

Te

It is possible to cancel the Options dialogue in order to discard the changes. This is done with the
"Cancel" button in the dialogue shown in Fig. 144.
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10.3 Program Description
Starting the program
There are several possibilities for starting the application after it has been installed. One way is to launch
the program from the Start Menu and another is to start the program with the Desktop shortcut or with the
icon in the System Tray.

fra

Te

c

Initialization

Fig. 162

Initialisation screen during the program start

The individual components are initialised after starting the program. The window shown in Fig. 162 is
displayed while doing so.

In

Fig. 163 Extract from the initialisation screen when the video connection is disabled
It is possible some components were disabled during the configuration (see chapter 10.1
67). The disabled components are shown like the example in Fig. 163 .

page

The initialisation takes place stepwise and is indicated by the following icons at the respective step.
initialisation step to be taken
Component is deactivated
Current step of initialisation
Successfully passed step of the initialisation

If an initialisation process needs to be cancelled, this can be done with the "Cancel" button in the lower
right-hand corner of the initialisation window. After that, the button is disabled and the text "Initialisation
cancelled" is displayed instead of "Initialisation in progress". Cancelling the initialisation can take
some time. The program closes automatically when the cancellation is complete.
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Fig. 164

Te

c

User Interface

Program user interface IRBISâ remote

fra

Depending on the activated components (see chapter 10.1
page 67), the appearance of the user
interface can vary. If all components are activated, the view shown in Fig. 164 appears. If only the
analogue video component is activated, the parts for remote control of the camera are removed and the
window shown on the left of Fig. 164 is displayed. If only the part necessary for remote control and
without the analogue video display, the appearance is like that shown on the right Fig. 164.

Toolbar with special buttons

In

Fig. 165

An additional change in the appearance happens if the "Special Buttons" were disabled in the
configuration. Then, the toolbar shown in Fig. 165 is not displayed. As a result, the corresponding
functions are not available.

The "normal" user interface (Fig. 164) is made up of three areas analogue video display, toolbar with
special buttons, and button emulation for remote control.
The analogue video display only displays the image supplied by the camera. The size of the displayed
image can be toggled between ordinary and enlarged resolution (see chapter 10.1 page 67).
Both the areas related to remote control toolbar with special buttons and button emulation for remote
control are described in detail in the following Section.
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Remote control operation

Fig. 166

Area with the camera buttons

c

Button emulation for remote control:

Te

The remote control of the camera is operated via the graphic shell of the camera. For the control of the
camera the buttons indicate in Fig. 166 are to be used.
The arrow buttons take the functions of the joystick of VarioCAMÒ. The buttons "A", "T", "S", "C" and
"E" do have the same functions as the buttons of the camera. The functions are different in dependence
of the respective context of the VarioCAM®.

fra

Autoimage/Start of automatic functions
setting of spots/openning of the spot editor/TAB-function in selected dialogues
Stop (Freeze) of the thermographic image/Quick save
Change palette/ESC-Function/Switching on and off of the VarioCAMÒ head
Enter function of the joystick/Confirmation of functions resp. dialogues

In

"A"
"T"
"S"
"C"
"E"
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11

Software IRBIS®

The IRBIS® main window consists of a work area, with a menu line and a toolbar above and a status
line below.

Menu bar

c

Toolbar

fra

Te

Work area

Fig. 167

Status line

IRBIS® main window

In

IRBIS® is graphics-oriented software. It is possible to use it with a VGA graphic resolution of 640 x 480
pixels and a 16-bit (High Color) colour depth. The True Color mode (24-bit or 32-bit) is recommended for
an optimal display.

11.1 Menu bar

The IRBIS® functions are operated via pulldown menus, whose top level is a menu line and contains the
following menu items:

Fig. 168

IRBIS® menu bar

File
Edit
View
Thermal Image
Measurement
Report
?

-
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11.2 Toolbar
The toolbar is located in the IRBIS® main window below the menu line and enables opening often
needed functions or arranging the location of measuring points and temperature profiles in the thermal
image. If the cursor is paused over an icon, its function is displayed.
The following functions can be reached via the corresponding toolbar buttons:

Fig. 169

IRBIS® toolbar

Te

Open file
Save file
Print

c

Common file functions (also accessible from the "File" menu)

Zoom functions (also accessible from the "View" menu)

fra

Zoom in
Zoom out
Select zoom

Other file functions (also accessible from the "File" menu)
Previous file
Next file

Marking functions (not accessible from the menu)

In

Set Selection

After clicking the "Set Selection" button, the cursor changes its appearance as soon as it is over the
thermal image. A rectangular area of the thermal image is marked by dragging a rectangle using the left
mouse button.
From now on, the functions "Export" and "Copy to clipboard" no longer
affect the complete thermal image, but instead only the marked areas. After
calling one of these functions, the marking is automatically removed. On
opening the menu item "Select" in the "Thermal image - Limits" menu, the
temperature limits inside the marked area are localised and the colour scale for
the resulting temperature range is aligned accordingly. The selection is
cancelled by pressing the "Set Selection" button again.
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Definitions of temperature profiles (not accessible from the menu)
Set Profile

c

After pressing the button, the cursor changes to a crosshair as soon as it is located on the thermal image.
If the menu item "Profile" in the "View" menu is not already activated, this happens automatically. In the
areas provided to the right of or below the thermal image, the vertical or horizontal temperature profile
corresponding to the current cursor position is displayed. During placement of the temperature profile,
you cannot exit from the thermal image window. Furthermore, no menu functions can be called either.
The crosshair is positioned by pressing the left mouse button which completes the definition of the
temperature profile. The temperature profile display can be removed by pressing the "Set Profile" button
in the toolbar again. Deactivating the menu item "Profile" in the "View" menu also results in automatic
removal of the temperature profile.

Set Point
Set Line
Set Rectangle
Set Ellipse
Set Circle
Set Polygon

Te

Arrangement of measuring or correction points (not accessible from the menu)

fra

After pressing the corresponding button, the cursor changes to a crosshair as soon as it is located on the
thermal image. Depending on the type selected, the placement of the measuring area is achieved as
follows:
A measuring point can put anywhere in the thermal image by clicking the left mouse
button.

Line:

Any starting point can be selected using the left mouse button. Afterwards the line is
drawn by holding down the left mouse button and dragging to the endpoint.

In

Point:

Rectangle: The starting point is selected using the left mouse button and the rectangle is "drawn"
by holding down the mouse button and dragging so that the endpoint is diagonally
opposite.

Ellipse:

An ellipse can be drawn by dragging with the left mouse button in a similar procedure
to that for the rectangle. Release the mouse button afterwards.

Circle:

A circle can be drawn by holding down the left mouse button and dragging from the
centre of the circle for the length of the radius. Release the mouse button afterwards.

Polygon:

First click the left mouse button on one, then on all the other corner points, complete
the placement by clicking the right mouse button.

The thermal image window cannot be exited and no menu functions can be called for as long as the
measuring point setting is not complete. The measuring points set can be modified or deleted via the
Operating Instructions
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menu item "Measuring Points ..." in the "Measurement" menu.

Automatic functions
Find Maximum
Find Minimum
The maximum or minimum temperature of the complete thermal image is automatically displayed by
pressing the corresponding buttons. If two-dimensional measuring areas (rectangle, ellipse, and polygon)
are defined, the maximum or minimum inside these areas is displayed simultaneously.

c

If the maximum value only occurs for a single pixel, the value is displayed with a bright yellow
background. If several pixels have the same measurement value, the display has a red background.

Additional functions
Audio comment
VIS image

Te

The maximum or minimum is removed from the thermal image by pressing the corresponding button
again.

fra

Existent additional information can be showed with these buttons, e.g. an audio file(.wav) saved in the
thermoimage or an image saved in digital camera. If this information is not existent, these buttons turn to
be grey.

11.3 Status line

In

There is a status line at the bottom edge of the IRBIS® main window where information about the
currently loaded thermal image and its representation is displayed.

Fig. 170

IRBIS® status line

The output fields have the following meanings, in their order of appearance:
Cursor position and temperature at the cursor position
Filename
Date and time the file was created
File status (O: Original file, O*: unsaved, modified original file, M: modifed loaded file)
Coordinates transformation (PPP1 Original image location)
Display mode (chapter 5.1 page 14)
Image status (GE: global emissivity)
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11.4 Work Area

IRBIS® work area

fra

Fig. 171

Te

c

The thermal image and optionally a temperature scale, measurement values, profile and a
comments field are displayed in the work area.

11.5 Profile

In

Using the corresponding Button in the toolbar, an horizontal and vertical temperature profile can be
determined at any point within the thermal image. Two output areas are provided below or on the right of
the thermal image for displaying the profile. These output areas are activated or disabled via the menu
item "Profile" in the "View" menu.

Fig. 172

horizontal temperature profile
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11.6 Measurement value table

fra

Te

c

IRBIS® permits the definition of ten measuring points and two measuring areas. In order to display the
measured values, a measurement value table can be overlaid in the work area via the menu item
"Measurement Values" in the "View" menu.

Fig. 173

Measurement value table

11.7 Comment

In

The file format of the thermal image files allows saving a comment on recording the image. This comment
is displayed in the comments field if it was activated via the "Comment" menu item in the "View" menu.

Fig. 174
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11.8 Parameter
Parameters are displayed in the parameters field if it was activated via the "Parameters" menu item in
the "View" menu. Optional additional information like taking time, filename etc. is displayed.

Fig. 175

Parameters field

11.9 Temperature Scale

fra

Te

c

The allocation of the temperature to each colour in the palette used is displayed in the temperature scale.

Standard Temperature scale Fig. 177

Standard Temperature scale with light
blue stripe

In

Fig. 176

Temperature ranges outside the calibration range of the thermograph camera and thus can
only be partially evaluated with respect to their radiometric accuracy are marked with an
additional light blue bar in the temperature scale.
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11.10 Menu "File"
The "File" menu contains all functions for processing SID or IRB files, export functions and print
functions.

Menu item "Open"
A SID or IRB file is opened and the thermal image with the currently active sundry parameters (colour
palette, temperature range selection, etc.) is displayed.

Menu item "Previous"
The previous alphabetical filename in the current SID or IRB directory is opened.

c

Menu item "Next"

Menu item "Save"

Te

The next alphabetical filename in the current SID or IRB directory is opened.

The currently loaded SID or IRB file is saved with the current name including the potentially modified
temperature parameters and potentially modified image content due to filtering. The original image
measurements must, however, be preserved, i.e. interpolated images cannot be saved, for example, as a
SID or IRB file.

Menu item "Save As"

fra

The function resembles that of "Save", yet here it is possible to give the file a new filename.

Menu item "Export"

The complete content of the current window or an area previously marked using "Set Selection" can be
exported. The following export formats are available:

In

BMP format
PCX format
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Menu item "Options"
It is possible to adjust the appearance and individual IRBIS® controls via a dialogue.

Fig. 178

Te

c

Tab "Presets"

"Options", tab "Presets"

Category "Autosave"

fra

Selecting both the checkboxes "Autosave" - "On Exit" and "Desktop", causes the state of the IRBIS®
window to be saved on ending the program, so that it is automatically resumed at the next program start.

Category "Scale: division lines"

The temperature scale display can be altered using the choice of "Scale: division lines" - "Without" or
"With".

Category "Decimals at temperature values"

In

The number of decimal places can be defined using "Decimals at temperature values".

Category "Export"

If the checkbox "Expand PCX" under "Export" is activated, all thermal images will be interpolated before
exporting.

Category "Fixed start values"
"Fixed start values" means, that the level and the range are fixed using numeric entries, if the checkbox
®
is activated. This change takes effect the next time IRBIS is started.

Category "Point label"
With the choice of "Point label" - "Label" or "Value", it can be defined whether a measuring point
should have the description or the temperature value on the label.
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"Options", tab "Directories"

Te

Fig. 179

c

Tab "Directories"

By selecting an SID or IRB file, it is possible here to set a "Working directory", a "Save directory", and
an "Export directory", which will be used as default directories in the dialogues for loading, saving, and
exporting files.

In

fra

Tab "Language"

Fig. 180

"Options", tab "Language"

While the program is running, it is possible to change the "Language" between German, English,
Russian and Spanish. For this the relevant character set for the corresponding language must be
installed on the computer.
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"Options", tab "Global Properties"

Te

Fig. 181

c

Tab "Global Properties"

Various special functions are available within this tab, these include settings for overwriting values from
the previous SID or IRB file using the "next/previous file" function, the standard wavelength, settings for
warning messages or choice of action on exceeding calibration.

In

fra

Tab "Comment/Parameters"

Fig. 182

"Options", tab "Comment/Parameters"

If the "From File" checkbox in the "Comment" section is activated, the comments from the IRB or SID
file are used. Otherwise any comment can be put in the input field.
The "Values for parameter line" section enables selection of parameters. The selection here is done
using a graphical editor, where the not selected parameters are displayed on the left and the selected
parameters are displayed on the right. The text entered under "Project" can be transferred to the
®
parameter field in the IRBIS main window using "Job" from the list in the graphical editor.
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Dialog for print

Te

Fig. 183

c

Menu item "Print"

The content of the IRBIS® window or alternatively a report page using predefined editable form fields is
printed on the currently selected printer. "Printer setup " selects the printer to be used and allows the
setting of its parameters.

Menu item "Exit"

fra

IRBIS® is closed down, whereupon previously specified settings according to the selection made under
"Options" are saved.

11.11 Menu "Edit"

The "Edit" menu contains all editing functions for modifying the image content except the temperature
measurement or correction. In addition, marked text from displayed window contents can be copied to the
clipboard.

Menu item "Copy to the clipboard"

In

The content of the current window or a part, which was previously marked with the "Set Selection"
button in the toolbar, can be copied to the (Windows ) clipboard.

Menu item "Filters"

The thermal image temperature values are submitted to filtering with the image processing methods.
"Clean"

uses a two-dimensional median filter on the thermal image, which is particularly effective for
pectinate structures in the image or deviating individual pixels. This filter step can only be
performed once per thermal image.

"Original" reinstates the unfiltered condition of the thermal image.
"Undo"

90

can undo the effects of the last filter used.

© InfraTec GmbH 2007

Operating Instructions

Operating Instruction for VarioCAM® head
11 Software IRBIS®

11.12 Menu "View"
The "View" menu contains all functions, which can affect the appearance of the current window.

Menu item "Zoom"
The zoom factor for displaying the image content is determined by selection from a list of available
values. Furthermore, you can switch between these steps for the marked input field by pressing the "left"
or "right" cursor keys.

Menu item "Profiles"
The display of profiles can be activated or disabled with the menu item "Profiles" in the "View" menu.

c

Menu item "Scale"

Te

A temperature scale is placed on the right next to the thermal image in the work area from which the
colour assignment of the measurement values is obvious.

Menu item "Measurement values"

In addition to the thermal image, two tables are placed in the work area, one of which contains the
current temperature measurement values and the other the current correction values in force (emissivity,
transmissivity).

Menu item "Comment"

fra

An output field is placed underneath the thermal image in the work area, in which the content of the
comment field of the current SID or IRB file is displayed.

Menu item "Parameters"

In addition to the thermal image, an output field is placed in the work area, in which the parameters
selected using "File" - "Options", Tab "Comment/Parameters" are displayed.

Menu item "Toolbar"

In

The toolbar can be activated or disabled using the "Toolbar" menu entry. The toolbar is activated by
default.
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11.13 Menu "Thermogram"
The "Thermogram" menu contains all the functions for influencing the graphic representation of the
thermal image.

Menu item "Limits"
This determines the method of establishing the upper and lower temperature thresholds of the converted
range of values on the colour scale.
sets the upper and lower thresholds to the range of values corresponding to the
temperature range set on the thermograph camera for the exposure.

"Object"

sets the upper and lower thresholds to the range of values utilised automatically in the
exposure.

"Range"

sets the upper and lower thresholds to the range of values corresponding to the
temperature measurement area set on the thermograph camera for the exposure.

"Direct..."

sets the upper and lower thresholds to values, which can be manually selected in the
"Level/Area" dialogue.

Te

c

"Shot"

In

fra

"Selection" sets the upper and lower thresholds to the converted range of values in the rectangular part
of the exposure, which was previously defined using the "Set Selection" button in the
toolbar.
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Fig. 184

Te

c

Dialogue "Level/Area"

Dialogue "Level/Area"

fra

®

IRBIS enables the display of the thermal image in a temperature range, which can be selected
independently of the range that was set on the camera for the exposure of the thermal image. However, it
must be noted, that the provision for under or overexposure is dependent on the digitalisation depth (8 or
16 bit) of the camera and on the selected aperture.

Category "Modus"

In

An automatic setting of the displayed temperature range can be made like that in the menu item "Limits"
of the "Thermogram" menu by selecting one of the 5 alternatives ("Exposure", "Image Content",
"Measuring Area", "Manual" or "Select") from the "Display" section.

Category "Direct"

Furthermore, it is possible to select the lower threshold "Min" and upper threshold "Max" in the "Direct"
section by numeric input and clicking on "Apply" afterwards.

Category "Level/Range"

A third possibility for selecting the temperature range is provided by the parameters "Level" (average
value of the display range) and "Range" (width of the display range). These can be either input as
numbers and applied by clicking "Apply" afterwards or continuously modified using the two scrollbars.
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Menu item "Palette"
The colour assignment of the measurement values for the display of the thermal image is arranged in a
preset palette.
selects a colour palette, which is optimal for the monitor display of the thermal
images and for inkjet colour printers. This also corresponds to the default
palette of the thermograph camera.

"2 Varioscan Printer"

selects a colour palette, which results in optimal image quality on colour laser
printers.

"3 black->white"

selects a monochrome colour palette with the assignment black=cold and
white=hot.

"4 white->black"

selects a monochrome colour palette with the assignment white=cold and
black=hot.

"5 Iron"

selects a colour palette, which corresponds to the tempering colours of steel.

"6 Blue->Red"

selects a colour palette with the assignment blue=cold via white to red=hot.

"Colors"

enables the selection of 16, 64, 128, 220, 256 or a numerically input
("Input...") number of shades for the display of the thermal images (e.g. 16
corresponds to 16 shades of grey or 16 different colours, depending on the
palette). The prerequisite for the higher resolutions is of course, that the
graphic mode provided on the graphic card of the PC supports at least one
corresponding resolution (High Color (= 16 bit or higher) is recommended).

fra

Te

c

"1 Varioscan"

Menu item "Quantity/Unit"

In

This defines the scale for displaying the physical size of the thermal image and which unit is used for the
scale labelling and measurement value output.
"Temperature (°C)"

defines a temperature scale display with the unit "Degrees Celsius".

"Temperature (°F)"

defines a temperature scale display with the unit "Degrees Fahrenheit".

"Temperature (K)"

defines a temperature scale display with the unit "Kelvin".
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Menu item "Parameters"

fra

Te

c

A dialogue with the physical radiation properties of the thermal image is displayed:

Fig. 185

Dialogue "Settings"

In

The ambient temperature and the emissivity can be modified in the "Emissivity" section. The
"Transmission/Reflection" section enables either the calculation of the transmission using the
"Extinction" section or a direct input in the "Absorption" section after choosing the temperature.
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Menu item "Isotherms"
The "Isotherms" dialogue is displayed for definition of 10 isotherms, which can be shown singly via
"Active".

Dialogue "Isotherms"

fra

Te

c

IRBIS® allows the display of up to 10 isotherms in the thermal image, and these let areas whose
temperature is in a defined range be highlighted.

Fig. 186

Dialogue "Isotherms"

In

The isotherms are distinguished by a lower ("T1") and an upper ("T2") temperature threshold of the
range to be highlighted and by a selectable colour. The thresholds must be entered in the unit (°C, °F or
K) currently set via the menu item "Size/Unit" in the "Thermal Image" menu, while the isotherms colour
can be selected with a graphical editor by clicking on "Colour...". Using the "Active" checkbox, it is
possible to show the isotherms with the defined parameters or to hide them. The settings made are
applied by clicking "Apply".

While the parameters for the isotherms 1 and 2 are always displayed in the dialogue, the parameters of
one of the isotherms 3 ... 10 can be shown as well in the lower part.
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11.14 Menu "Measurement"
The "Measurement" menu contains the "Definitions ..." menu item. If this menu item is selected, a
dialogue box with the tabs Measuring Points and Measuring Areas is opened, where the measuring
points defined via the toolbar are displayed and their emissivity can be modified or deleted from the
thermal image.

Measuring Points tab

In

fra
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The "Measuring Points" tab is used for the display of the defined measuring points in the thermal image
and for the display of the temperature at the cursor.

Fig. 187

Dialogue "Measuring"

Fig. 188

Dialogue "ROI"

The currently defined measuring points are displayed line by line in a table. All the measuring points set
are listed in this table and can be modified with respect to their emissivity. For this, a context menu is
opened by clicking on the desired menu item with the right mouse and then selecting the
"Edit epsilon..." context menu entry. The measuring point can be deleted with the "Clear" context menu
item. The "Clear all" button removes all measuring points from the thermal image.

The defined measuring areas are displayed on the Measuring Area tab and can be corrected with respect
to their emissivity.The type, the average value, the minimum, the maximum, and the standard deviation
are displayed for the defined measuring areas of the thermal image in the "Measured area 1"/
"Measured area 2" section. The corresponding measuring area can be deleted using the "Delete"
button. The emissivity can be modified in the "Emissivity" input field.
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11.15 Menu "Report"
The report generator is a tool for easy documentation of a thermal image evaluation.

Benefits
1.
2.

Automated evaluation/documentation of large image sequences.
Individual post-processing of single thermal images by reloading the thermal images into the work
area of IRBIS® professional.
Accomplishes complex automation requirements in addition to the routine evaluations/documentation
of thermograph recordings

Te

c

3.

Header

Logo

fra

Title

In

Image description

Parameter area

Comment area

Footer

Fig. 189

Report appearance

The parameters previously selected via "File" - "Options" in the "Comment/Parameters" tab are
displayed automatically as text in the parameter area.
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Menu item "New"
After selecting this menu item when creating a new report, the "Report properties" dialogue is opened,
where the default settings for the new report can be found.

Dialogue "Report properties"

fra

Te

c

This dialogue box is used to design the report page layout, i.e. the header and footer, the image
description, the title, and the comments.

Fig. 190

Report properties, tab "Header/Footer"

The "Header/Footer" tab enables the pre-allocation of the text for the header and footer and the image
description.
The following parameters can be entered for the header/footer:

In

%D = date
%T = current time
%S = current page number
%N = number of pages
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Selection of the company logo

Selection
template

of

the

report

Report properties, tab "Title"

Te

Fig. 191

c

Entry of the report title

In

fra

The Title tab enables the definition of the logo, the report template, and the title.
The logo and the template can be changed by clicking "..." and selecting an appropriate file.
Any text can be entered for the title.

Fig. 192

Report properties, tab "Comment"

The "Comment" tab permits the adoption of a comment in the comment area of the report window.
The new report is created after clicking the "OK" button.
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The Report Window
The report window enables the insertion of thermal images, the entry of image descriptions, and the text
formatting of the separate text input fields.
The report window consists of a toolbar, the report work area, and a status line.

Work area

In

fra

Te

c

Toolbar

Status line
Fig. 193

Report window overview
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The Toolbar
If the cursor is hovered over an icon, its function is displayed.
From left to right, the icons in the toolbar mean the following:

1st Row

Fig. 194

1st row of the toolbar in the report window
This button closes the report window. If the report has not been saved yet, an
appropriate message window is displayed and the report can be saved.

Open ...

A dialogue for opening a report is displayed, the report is loaded after selecting a
file.

Save

The current report is saved, if there is no filename yet, this can be specified in a
save dialogue.

Save As...

This function is the same as Save, except that a new filename can be specified
here.

Change template

A selection dialogue for changing the report template in the current report is
displayed. This contains the available templates with an image icon and a sort
description.

In

fra

Te

c

Close

Fig. 195

Dialogue for changing the report template

Save As Template

The current report template can be saved.

Preview

The current report page can be displayed in a preview window and printed if
required.

Print... [Ctrl+P]

The complete report is printed.
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2nd Row

Fig. 196

2nd row of the toolbar in the report window
Navigation to the first page of the report.

Previous

Navigation to the page immediately before the current page.

Scrollbar

Using the scrollbar, you can navigate around the complete report. The current
page is displayed underneath the scrollbar.

Next

Navigation to the immediately following page.

Last

Navigation to the last page of the report.

Insert

A new page using the selected template is inserted before the current page in the
report.

Append

Using the selected template, a new page is added to the report after the last page.

Delete

The page currently displayed is deleted from the report. This function is disabled if
there is only one page in the report.

fra

The Report Work Area

Te

c

First

Depending on the template loaded, it is possible to load one more images on the current page. This is
accomplished by clicking on the image area with the right mouse button
a context menu is then
displayed.

In

"send irb to irbis" is only active, if you are dealing with an IRB file for the
®
image and sends the thermal image back to the IRBIS professional main
window.
With "load Image ..." any BMP or JPEG file can be loaded in to the image
area.
"delete Image" deletes the image in the image area where the context menu
was opened.

In addition, it is possible to import an IRB image in to the report. For this, a
context menu is displayed in the "IRBIS® professional" main window by
clicking on the thermal image with the right mouse button. The thermal image
is sent to the report using the "Report" menu item. If a report template with
several image areas is selected, it is possible to select the image area.
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A context menu is displayed when clicking on the "Logo" field with the
right mouse button where a company logo can be removed or loaded.
Font and point size can be changed using the menu items "Font" and
"Point Size" on the context menu, which is displayed by clicking
anywhere in the comment area, parameter area, title area, header and
footer areas with the right mouse button. The "font" and "point size" can be
specified in the "Others" submenu. A new menu entry is applied in the
relevant submenu after specifying the font and point size.

c

The Status Line

Fig. 197

Te

The status line provides detailed information concerning the description of the toolbar buttons when the
mouse pointer is located on a button.

Status line of the report window

Menu item "Open... "

fra

An existing report can be opened with an open dialogue and selection of a report file. Afterwards, this is
displayed in the report window.

Menu item "Actualize"

If this menu item is selected, the current page in the report is completely refreshed. In doing so, the
comment area and the parameter area are updated. In addition, the currently loaded thermal image in the
IRBIS® professional main window is inserted into the first image area of the report window.

11.16 Menu "?" (Help)

In

The "?" menu contains functions for online help and copyright information.

Menu item "Help"

The online help for IRBIS® is opened. In addition, it is possible for context-specific help text on menu
entries and dialogue boxes to be displayed by moving the mouse (without clicking) over the relevant
element and pressing the F1 key.

Menu item "About"
Program information and copyright notices are displayed.
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Maintenance

Cleaning
The possible maintenance work on the VarioCAM® head is limited to the cleaning of external surfaces.
The optical faces of the lens are provided with high-quality optical coatings. Do not touch
these areas and protect them against dirt and damage. Always replace the proper cover on
the lens when the camera is not in use.

c

Nevertheless, if cleaning the optic faces should become necessary, please only use woodfree cotton or
Kleenex Professional Wipes Kleenex in combination with 96% ethanol.
For severe soling, please contact the manufacturer.

Te

If the lens has been unscrewed (lens replacement), the opening of the camera casing must
be protected against any kind of contact with the internal components. It must be ensured,
that no contamination penetrates the inside of the camera. Any kind of intrusions in to the
inside of the camera are expressly prohibited.
Maintenance and repair work described in this instruction manual must only be performed by authorised
qualified staff. Non-compliance voids the manufacturer's guarantee and liability.

Calibration

fra

The VarioCAM® head system was very carefully calibrated at the manufacturer in compliance with the
national standard.

In

It is recommended to have the calibration checked by the manufacturer or another certified institution
every two years. This check should be combined with general device maintenance.
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Environmental Protection

VarioCAM® is an optoelectronic device, which contains special infrared optics and electronic printed
circuit boards. These components require special disposal at the end of the equipment's service life.
The manufacturer offers to take back the VarioCAM® head product from the customer at the end of the
equipment's service life to guarantee environmentally-acceptable disposal.

In

fra

Te

c

In this case, please send the equipment to the address mentioned in Section 14 "Service".
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Service

The manufacturer recommends servicing the VarioCAM® head system by Customer Service every two
years.
The manufacturer guarantees the servicing on the VarioCAM® head product.

+49 351 871 - 8615
+49 351 871 - 8727
service@InfraTec.de
www.InfraTec.net

In

fra

phone:
fax:
e-Mail:

Te

InfraTec GmbH
Infrarotsensorik und Messtechnik
Gostritzer Straße 61-63
01217 Dresden
GERMANY

c

In the event of faults and for performing technical servicing, please contact your authorised dealer or
Customer Service at the following address:
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